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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
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Copyright Notices
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Trademark Notices
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computers are Open Group UNIX 95 branded products.

Intel and Pentium are registered trademarks of Intel Corporation or its subsidiaries in the 
United States and other countries.
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Support

Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support 

This web site provides contact information and details about the products, services, and 
support that HP OpenView offers.

HP OpenView online software support provides customer self-solve capabilities. It provides a 
fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many 
also require a support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/passport-registration.html 
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Documentation Roadmap

Figure 1 on page 8 shows the documentation roadmap for HP OpenView 
Dashboard Operations View. This roadmap presents a suggested order for 
reading the manuals available with Operations View:

1 Use the Installation Guide to install the product.

2 Follow the path for Operations View.

a Use the Operations View Quick Start Guide to carry out the tutorial.

b Read the “Essential Concepts” chapter of the Operations View 
Administrator Guide to understand the concepts of working with 
portlets and portal servers.

c Use the Operations View Administrator Guide to configure and 
maintain the product. This guide provides high-level instructions for 
the common tasks when working with the supplied Operations View 
portlets 

d If you are migrating from HP OpenView Service Information Portal to 
Operations View, use the Operations View Migration Guide to 
complete this task. The Operations View Administrator Guide refers 
you to the Operations View Migration Guide at the appropriate point 
in the portal view implementation process.

e Reference the integration guides as needed for specific details on each 
supported HP OpenView management product. The Operations View 
Administrator Guide refers you to the integration guides at the 
appropriate points in the portal view implementation process.
7



Figure 1 Operations View Documentation Roadmap
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HP OpenView Dashboard Manuals

Table 1 describes the HP OpenView Dashboard manual set. These documents 
are provided in Adobe Acrobat (.pdf) format and can be found in the following 
directories:

• After HP OpenView Dashboard installation, in the following directory on 
the HP OpenView Dashboard management station:

— Windows: <install_dir>\paperdocs\dashboard\

— UNIX: /opt/OV/paperdocs/dashboard/

• On the product DVD-ROM in the following directory:

— Windows: \Docs\

— UNIX: /Docs/

For information on how to obtain the most recent documents, see 
Documentation Updates on page 13.

Table 1 HP OpenView Dashboard Documentation

Document Title and Filename Main Topics

Installation Guide
Installation.pdf

Installing and uninstalling HP OpenView 
Dashboard

Operations View Quick Start Guide
opview/Quick_Start.pdf

• Running the Operations View 
demonstration portal view

• Operations View tutorial

Operations View Administrator Guide
opview/Administration.pdf

• Essential concepts
• Planning roadmap for using Operations 

View
• Connecting Operations View to 

management products
• Configuring Operations View portlets
• Configuring Operations View data filters
• Deploying a portlet application
• Troubleshooting
9



Operations View Migration Guide
opview/Migration.pdf

• Overview of migrating from 
HP OpenView Service Information Portal 
(SIP) version 3.2 to Operations View

• SIP and Operations View comparison
• Migration use models
• Using the Operations View Migration 

Wizard
• Manual steps for migration
• Troubleshooting

Operations View Integration Guide: NNM
opview/NNM_Integration.pdf

• Connecting Operations View to 
HP OpenView Network Node Manager 
(NNM)

• Configuring the NNM portlets
• Customizing the NNM portlets
• Filtering NNM data
• Troubleshooting

Operations View Integration Guide: OVO and 
OVSN
opview/OVO_OVSN_Integration.pdf

• Connecting Operations View to 
HP OpenView Operations (OVO) and 
HP OpenView Service Navigator (OVSN)

• Configuring the OVO and OVSN portlets
• Customizing the OVO and OVSN portlets
• Filtering OVO and OVSN data
• Troubleshooting

Operations View Integration Guide: OVIS
opview/OVIS_Integration.pdf

• Connecting Operations View to 
HP OpenView Internet Services (OVIS)

• Configuring the OVIS portlets
• Customizing the OVIS portlets
• Troubleshooting

Table 1 HP OpenView Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
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Operations View Integration Guide: OVPM
opview/OVPM_Integration.pdf

• Connecting Operations View to 
HP OpenView Performance Manager 
(OVPM)

• Configuring the OVPM portlets
• Customizing the OVPM portlets
• Filtering OVPM data
• Troubleshooting

Operations View Integration Guide: OVSD, 
OVPI, and OVR
opview/OVSD_OVPI_OVR_Integration.pdf

• Connecting Operations View to 
HP OpenView Service Desk (OVSD), 
HP OpenView Performance Insight 
(OVPI), and HP OpenView Reporter 
(OVR)

• Configuring the OVSD, OVPI, and OVR 
portlets

• Customizing the OVSD, OVPI, and OVR 
portlets

• Troubleshooting

Table 1 HP OpenView Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
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Operations View Online Help

Operations View supplies the following graphical interfaces for portal and 
portlet configuration:

• Operations View Administrator Tool

• Operations View Migration Wizard (available from the Administrator 
Tool)

Each of the Operations View graphical interfaces includes online help files 
that explain that interface.

• To access the top level of the help content for each interface, use the 
commands on the Help menu.

• To access context-specific help information in the Operations View 
interfaces, click Help within the window for which you want more 
information.
12



Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of 
the software

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales representative for 
details.
13



Documentation Conventions

The Operations View documentation uses the following conventions:

Table 2 HP OpenView Dashboard Documentation Conventions

Symbol Meaning

<install_dir> (Windows only.) The HP OpenView application directory. This 
directory contains all of the HP OpenView Dashboard files. The 
default location is:
C:\Program Files\HP OpenView\

<data_dir> (Windows only.) The HP OpenView data directory. This 
directory contains product configuration and data files. The 
default location is:
C:\Program Files\HP OpenView\data

<portlet_app_dir> The top-level directory for a deployed portlet application. This 
directory has the same name as the portlet application. The 
location of this directory depends on the installation platform 
and the portal server.
• Jetspeed on Windows:

<install_dir>\nonOV\dashboard\jetspeed\1.6\jakarta
-tomcat-5.5.9\webapps

• Jetspeed on UNIX:
/opt/OV/nonOV/dashboard/jetspeed/1.6/
jakarta-tomcat-5.5.9/webapps

• BEA WebLogic on Windows (default):
<bea_install_dir>\user_projects\applications

• BEA WebLogic on UNIX (default):
<bea_install_dir>/user_projects/applications

<bea_install_dir> is the BEA WebLogic directory.

A note that describes special information pertaining to the 
current topic.

A tip that provides an alternate way to address the current 
topic.

A caution that indicates a potential problem to avoid.
14



1 Introduction
Migration is the process of porting your portal configuration from 
HP OpenView Service Information Portal (SIP) version 3.2 to HP OpenView 
Dashboard Operations View version 2.0.

If your company has not used SIP, migration does not apply to you.

If your company currently runs SIP, you might want to migrate your SIP 
configuration to Operations View. The alternative to migration is to build your 
Operations View configuration by hand.

The Operations View Migration Wizard copies SIP configuration files to their 
appropriate locations on the Operations View computer and updates these 
files as necessary to match the Operations View file formats. The Operations 
View migration tool can automate much of the work for migrating your SIP 
configuration. You will complete the process by using the Operations View 
Administrator Tool and your portal server software tools.

Your approach to migration will be specific to your environment. This manual 
explains the support for migration provided with Operations View and helps 
you decide on the best way to carry out your migration in your environment.

It is helpful to be familiar with the following topics before beginning to 
migrate your SIP configuration:

• The current SIP version 3.2 configuration. Understanding how SIP is 
configured can make it easier to determine how the migrated 
configuration will function.

• The process for configuring a portal with Operations View. Walk through 
the Operations View tutorial in the Operations View Quick Start Guide to 
understand the integration between Operations View and the portal 
server software.

• Your portal server software tools. If you are using the embedded Apache 
Jetspeed portal server, the tutorial provides an introduction to these tools. 
If you are using BEA WebLogic, refer to that product’s documentation for 
information about the portal configuration tools.
 15



HP OpenView Dashboard Operations View Migration Guide Version 2.0
This manual contains the following chapters:

• Migration Process Overview lists the prerequisites for migration and 
presents an overview of the migration process and available options.

• SIP and Operations View Comparison compares the SIP and Operations 
View architectures and configurations and identifies the method for 
migrating each aspect of a configuration.

• Migration Use Options discusses several viable approaches to migration.

• Using the Migration Wizard details the migration process.

• Manual Steps for Migration describes optional migration tasks that the 
Operations View Migration Wizard does not do.

• Best Practices lists recommended best practices for migration.

• Glossary defines terms related to SIP and Operations View.
16 Chapter 1



2 Migration Process Overview
Migration from HP OpenView Service Information Portal (SIP) version 3.2 to 
HP OpenView Dashboard Operations View version 2.0 involves the following 
tasks:

1 Read and meet the prerequisites described in Prerequisites.

2 Decide which SIP content to migrate to Operations View. For information, 
see Chapter 4, Migration Use Options.

3 Run the Operations View Migration Wizard as described in Chapter 5, 
Using the Migration Wizard.

4 (Optional.) Perform manual migration as described in Chapter 6, Manual 
Steps for Migration.

After you have completed the migration process, you can use the Operations 
View Administrator Tool to expand and maintain the Operations View 
configuration.

The Migration Wizard overwrites some existing Operations View 
configuration files; therefore, complete migration before initiating new 
configurations in the Administrator Tool. For more information on the effects 
of specific aspects of running the Migration Wizard, see Chapter 4, Migration 
Use Options.
 17



HP OpenView Dashboard Operations View Migration Guide Version 2.0
Prerequisites

Before starting the migration process, you must meet all of the following 
prerequisites.

Software

The following software products are required to fully migrate a SIP 
configuration:

• SIP version 3.2. If you are running SIP version 3.0 or 3.1, you must first 
update to version 3.2 before migrating your configuration to Operations 
View.

• Operations View version 2.0. Operations View can be installed on the 
same computer as SIP or on another computer.

• A supported portal server software product. For Operations View version 
2.0, the supported portal server software products are as follows:

— Jetspeed version 1.6 plus Fusion with a custom patch (supplied with 
HP OpenView Dashboard) and Tomcat version 5.5.9

— BEA WebLogic Portal Server version 8.1 with service pack 4

Access

The following access requirements must be met to fully migrate a 
configuration:

• The Operations View computer must be able to access the 
SIPPath.properties file and all SIP configuration files for the SIP 
deployment.

• You must have administrator or root access to the Operations View server.

• You must have administrator or root access to the portal server software.
18 Chapter 2



Version 2.0 HP OpenView Dashboard Operations View Migration Guide
Disk Space

The Operations View server must have adequate disk space to store the 
migrated configuration files. The amount of disk space needed depends on the 
size of the configuration that you are migrating. As a minimum, ensure that 
you have enough disk space to hold the current SIP configuration plus 
additional space for storing migration staging and portlet application 
contents. The amount of additional space required increases each time you 
run the Migration Wizard.

To determine the size of the current SIP configuration, do the following on the 
SIP server:

• Windows: In the Windows explorer, navigate to <install_dir>\SIP, 
right-click conf, and then click Properties.

• UNIX: Use the following command to display the disk space usage in 
kilobytes:
du -sk /opt/OV/SIP/conf
Migration Process Overview 19



HP OpenView Dashboard Operations View Migration Guide Version 2.0
Platform Support

Operations View supports migration on the same operating system only.

• If SIP 3.2 runs on the Windows operating system, you can migrate your 
module configurations to Operations View running on the Windows 
operating system.

For cross-system migration, map a drive on the Operations View server to 
the SIP configuration directory.

• If SIP 3.2 runs on a UNIX operating system, you can migrate your 
configurations to Operations View running on a UNIX operating system.

For cross-system migration, use NFS to mount the SIP configuration 
directory on the Operations View server.

If you are doing cross-system migration, you must modify a copy of the SIP 
3.2 SIPPath.properties file to point to the remote drive. For 
information, see Task 1: Prepare for Migration on page 43.

Operations View migration does not support cross-platform migration 
between the Windows and UNIX operations systems.
20 Chapter 2



3 SIP and Operations View Comparison
This chapter describes the differences between HP OpenView Service 
Information Portal (SIP) and HP OpenView Dashboard Operations View. This 
chapter also relates the individual terms of a SIP configuration to those of an 
Operations View configuration.
 21



HP OpenView Dashboard Operations View Migration Guide Version 2.0
Product Comparison

SIP includes an embedded portal server and the SIP Configuration Editor for 
configuring management stations and management data filters. You managed 
all stages of portal view development within the SIP portal server.

Operations View supports multiple third-party portal server products; 
therefore, the Operations View Administrator Tool manages the initial 
configuration and ongoing maintenance of the Operations View portlet 
applications that are available to the portal server product. You will use the 
third-party portal server product tools to create and manage the portal users, 
roles, and views.

The Operations View Migration Wizard migrates the core functionality of your 
SIP configuration to the Operations View formats. This section describes the 
important differences between SIP configuration and Operations View 
configuration.

Figure 2 on page 23 shows the types of SIP data that can be migrated to 
Operations View and indicates the migration results. The following sections 
explain the Operations View terms, and Table 3 on page 27 summarizes the 
differences between SIP and Operations View terminology.
22 Chapter 3
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Figure 2 SIP to Operations View Comparison
SIP and Operations View Comparison 23



HP OpenView Dashboard Operations View Migration Guide Version 2.0
Management Stations

A management station definition identifies a computer on which one or more 
management software products runs. It also specifies parameters for 
connecting to the management products on that computer.

This definition is very similar in both SIP 3.2 and Operations View.

The migrated management station information is available in the 
Management Stations folder in the Administrator Tool.

Filter Assignments

A filter assignment associates one or more portal server roles with the 
customer data these roles are permitted to view. The Operations View filter 
assignment serves the same purpose as the management data filter in SIP. 
HP has changed the way it references this concept to stress that a filter 
assignment does not directly filter the available data. Instead, it specifies the 
intersection of the customer data model and the assigned portal server roles.

The migrated management data filter information is available in the Filter 
Assignments folder of the Data Filters folder in the Administrator Tool.

Organization

An organization is the logical group of resources, such as nodes and services. 
Typically, an organization relates to a group of users in the portal and lists the 
resources these users can access.

This definition is the same in both SIP 3.2 and Operations View.

The migrated organization information is available in the Customer Model 
Sources folder in the Data Filters folder in the Administrator Tool.

Customer Models

A customer data model maps organizations to their available resources. This 
concept is the same in SIP and Operations View.

The migrated customer model information is available in the Customer Model 
Sources folder of the Data Filters folder in the Administrator Tool.
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Users, Roles, and Groups

In SIP, only one portal view can be associated with a given role, and a 
separate role is required for each user who wants to customize the look and 
feel of the portlets in the view. With Operations View, the portal server 
supports multiple users each uniquely customizing the look and feel of the 
view. If your SIP environment includes multiple roles that access the same 
view, you might be able to reduce the number of roles that access portal views.

Users, roles, and groups are now managed by the portal server software, and 
the portal server supports portal view personalization per user. Each role now 
defines a distinct grouping of users with different portal view access 
permissions, and each role can be associated with an unlimited number of 
management data filters.

The migration data is not available in the Administrator Tool. Instead if you 
select to migrate users and/or roles, the Migration Wizard creates a script 
containing the SIP user and role names. You can use this script to import your 
user and role information into your portal server.

Portlet Applications

In Operations View, a portlet application is a group of JSR168-compliant 
portlets combined with functionality that is specific to the target portal server 
product. It is the portlet application that is deployed to the portal server. 
Within the portlet application are the portlets that can be used within a portal 
view.

This concept is not available in SIP 3.2.

Each use of the Migration Wizard migrates the selected SIP modules into a 
single portlet application within the Administrator Tool. You can then use the 
Administrator Tool to manage these portlets.

Portlets

When referring to functional components of a portal view, Operations View 
uses the term portlet while SIP uses the term module. The use and purpose of 
a portlet has not changed from the use and purpose of a module, but the 
implementation has changed.
SIP and Operations View Comparison 25



HP OpenView Dashboard Operations View Migration Guide Version 2.0
In SIP, a module is the intersection of the SIP-supplied integration 
functionality, with configuration inferred from the view definition, and the 
role properties.

In Operations View, a portlet is simply the Operations View-supplied 
integration functionality with standards-based configuration information for 
JSR168 portlets. The role and view information comes into play at the portal 
configuration, which is outside the scope of Operations View. It is important to 
understand this distinction during the migration process.

The portlets within a given portlet application must each be uniquely named. 
The Migration Wizard assigns a unique name to each portlet during the 
migration process.

The migrated portlets are available in the migrated portlet application folder 
within the Administrator Tool.

Portal Views

Portal view are now managed by the supported third-party portal server 
products. These portal server products offer many portal view configuration 
options that were not available in SIP. For example, a single portal view can 
contain multiple portlets, each of which might have several associated 
management data filters. Thus, multiple users can access the same portal 
view but see only the data to which they have access.

In Jetspeed, all users of a given portal view see the same portlet 
customizations within the constraints of the filter assignments. A portlet that 
appears in multiple portal views can be customized uniquely in each portal 
view.

In BEA WebLogic, each user can customize his or her version of the portal 
view without impacting any other user of the same portal view.

Because portal view configuration is specific to the portal server, the 
Migration Wizard does not migrate SIP portal views. You will use the portal 
server software tools to build new portal views for the Operations View 
environment. These new portal views can take advantage of the additional 
portlets provided with Operations View.
26 Chapter 3



Version 2.0 HP OpenView Dashboard Operations View Migration Guide
Table 3 Product Terminology Comparison Summary

SIP Term Operations View Term Comments

Management station Management station

Management data filter Filter assignment

Customer model Customer model The customer model concept 
has not changed.

Users, roles, and groups
Only one portal view can be 
associated with a given role, 
and a separate role is 
required for each user who 
wants to customize the look 
and feel of the portlets in the 
view.

Users, roles, and groups
The portal server supports 
multiple users each uniquely 
customizing the look and feel 
of the view.

Users, roles, and groups are 
now managed by the portal 
server software product.

SIP Portlet application Each use of the Migration 
Wizard migrates the selected 
SIP modules into a single 
portlet application. Note that 
data filters and customer 
models are also migrated.

Module Portlet

View Portal view Portal views are now 
managed by the portal server 
software product.
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What is Migrated

The Operations View Migration Wizard migrates the core functionality of your 
SIP configuration to Operations View. 

Figure 2 on page 23 shows the types of SIP data that can be migrated to 
Operations View and indicates the migration results. Table 4 expands on the 
information presented in the figure. 

Table 4 SIP Data Available for Migration to Operations View

SIP Data Migration Input Operations View Data Migration Output

Management station definitions file

(conf/share/stations/mgmtStations.xml)

Management station definitions file
Available in the Management Stations folder 
in the Administrator Tool

Management data filter definition file(s)
(conf/share/roles/*.xml)

Filter assignment definition file(s)
Available in the Filter Assignments folder in 
the Data Filters folder the Administrator 
Tool

Customer model definition file(s)
(conf/share/organizations/*.xml)

Customer model definition file(s), including 
the NNM Simple Customer Model
Available in the Customer Model Sources 
folder in the Data Filters folder in the 
Administrator Tool

User definitions
(conf/share/users/*.xml)

A script containing SQL commands that can 
be run to update the portal server database 
with the user and/or role definitions. If both 
users and roles are migrated, this script also 
includes the associations between users and 
roles.
(datafiles/dashboard/opview/migratedData/
scripts)

Role definitions
(conf/share/roles/*.xml)

View definitions
(conf/share/views/*.xml)

Not migrated
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Module configurations
(conf/share/modules/*/*.xml)

Portlet configurations
Available in the folder for the portlet 
application in the Portlet Applications folder 
in the Administrator Tool

Module help files
(htdocs/C/help/SIP/*.html)

Not migrated

Table 4 SIP Data Available for Migration to Operations View (cont’d)

SIP Data Migration Input Operations View Data Migration Output
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What is Not Migrated

This section lists the portions of the SIP configuration that must be migrated 
manually.

Portal Views

With Operations View, user-specific preferences allow a single portal view to 
share many configurations, and a single portlet can have many different 
filters applied against it. You will probably need fewer portal views with 
Operations View than you used with SIP.

Use the portal server software tools to design your portal views utilizing the 
migrated portlets. You might want to refer to the SIP views during this 
process.

Help Files

Each migrated portlet configuration includes a reference to the standard 
Operations View help topic for that portlet. If the SIP configuration includes 
customized help content, you can modify portlet configurations to use this 
customized content.
For information on migrating custom help content, see Help File Migration on 
page 54.

Images

Manually migrate any images used in SIP message board or generic modules. 
Copy the image files to the Operations View server, and then modify your 
portlet configuration to reference the new location for the image files.

Formatting and Skin Files

Manually migrate any formatting and skin files such as cascading style sheets 
(CSS). Copy these files the Operations View server, and then modify the 
respective configuration to reference the new location for the files.
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Authentication and Authorization

The benefits of implementing portal server security include the following:

• Security prevents unauthorized users from viewing portal content.

• Portal view customizations can be saved for an authenticated user but not 
an anonymous user.

Each supported portal server offers several ways to achieve portal security. 
Select and implement the approach that is best for your environment. The 
Migration Wizard can create a script that configures the SIP users and roles 
in the portal server software.

For information on running this script, see Users and Roles on page 62.

Third-Party SIP Integrations

Operations View does not support the third-party integrations that were 
provided with SIP on a contributed basis. The configuration might continue to 
work, but HP does not provide support in this area. Instead, HP recommends 
that you locate and use JSR168-compliant third-party portlets such as the 
iframe portlet provided with Jetspeed.

Immediately after a portal is deployed, it has no specific access rights. Use the 
portal server software tools to set the access rights for the portal before 
advertising the portal’s availability.
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The One-to-Many Result

For each SIP module that is associated with a role, the Migration Wizard 
creates one portlet definition. If many roles access the same module, that 
single SIP module definition can become a large number of nearly identical 
Operations View portlet definitions. Chapter 4, Migration Use Options 
discusses possible ways to deal with this multiplicative effect.

Figure 3 illustrates the idea of many unique portlets from one module. View X 
contains 3 modules and is associated with two roles, Role A and Role B. The 
result of migration is six unique portlets.

Figure 3 Module to Portlet Multiplicative Effect
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4 Migration Use Options
Every HP OpenView Service Information Portal (SIP) deployment is unique, 
so no migration will be the same. The Migration Wizard is very flexible to 
accommodate a wide variety of SIP configurations. There is no one right way 
to migrate your SIP data to Operations View. The approach you choose 
depends on your familiarity with the SIP configuration, the volume of data to 
migrate, and your preferred method of working.

This chapter describes several use models. Read through each description to 
determine which combination of these approaches is best for your situation.

• Migrate Modules on page 34

• Migrate Management Stations on page 35

• Migrate Management Data Filters on page 36

• Migrate Users and Roles on page 37
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Migrate Modules

If your SIP configuration contains many roles, migrating all modules could 
result in an unmanageable number of portlets. (See The One-to-Many Result 
on page 32.) In this case, you can select to migrate only some of the SIP 
modules.

If your SIP configuration is very close to the planned Operations View 
configuration, you can migrate all modules.

Migrating even a single module results in the following changes:

• The existing Operations View management station configuration is 
replaced with the SIP management station information. Any changes 
made in the Administrator Tool prior to migration will be lost.

• The Operations View customer models and filter assignments are replaced 
with the SIP information. Any changes made in the Administrator Tool 
prior to migration will be lost.

• The portlet application you named at the beginning of migration contains 
that portlets that were created from the modules you selected to migrate.

Figure 4 shows the effect of module migration.

Figure 4 Module Migration
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Migrate Management Stations

HP recommends that you use the Migration Wizard to migrate your 
management station definitions from SIP to Operations View. Management 
stations are migrated into Operations View in a on-to-one manner. Migrating 
one or more modules also migrates the management station definitions.

Figure 5 shows the effect of management station migration.

Figure 5 Management Station Migration

Each time you migrate management stations, the Administrator Tool 
management station configuration is replaced with the newly migrated 
management station data. Therefore, migrate management stations before 
initiating configuration work in the Administrator Tool.
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Migrate Management Data Filters

HP recommends that you use the Migration Wizard to migrate your 
management data filter definitions from SIP to Operations View. 
Management data filters are migrated into Operations View as customer 
models and filter assignments. The NNM Simple Customer Model is migrated 
as a customer model source. Migrating one or more modules also migrates the 
management data filter definitions.

Figure 6 shows the effect of data filter migration.

Figure 6 Data Filter Migration

Each time you migrate management data filters, the Administrator Tool filter 
assignment configuration is replaced with the newly migrated filter 
assignment data. Therefore, migrate management data filters before 
initiating configuration work in the Administrator Tool.
36 Chapter 4



Version 2.0 HP OpenView Dashboard Operations View Migration Guide
Migrate Users and Roles

If the user and role definitions for your new portal will be very similar to those 
used in the SIP configuration, HP recommends that you use the Migration 
Wizard to create a user/role configuration script for importing into your portal 
server.

If you migrate both user and role definitions in the same session of the 
Migration Wizard, the script also includes the associations between users and 
roles. You can also choose to migrate only users or only roles. In that case, you 
can import the SQL script into your portal server software and use the portal 
server software tools to complete the user and role configuration.

Figure 7 shows the effect of user and role migration.

Figure 7 User and Role Migration

For information about the contents of the portal server database configuration 
script that the Migration Wizard creates, see the following section that 
pertains to your portal server software product. For information about how to 
use the script to configure users and/or roles in the portal server database, see 
Users and Roles on page 62.

You can migrate user and role definitions at any time. This migration does not 
overwrite any Operations View configuration files. If you migrate only users 
and roles, your migration portlet application will be empty.
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Jetspeed

The script for importing users and roles into a Jetspeed database is named 
setupJetspeedTurbineSecurity_<portlet_app_name>.sql and is 
available in the following directory:

• Windows: <data_dir>\datafiles\dashboard\opview\
migratedData\scripts

• UNIX: /var/opt/OV/datafiles/dashboard/opview/
migratedData/scripts

The contents of the configuration script depend on what you migrate:

• If you migrate only users, the script contains commands to update the 
Jetspeed database with the following information:

— User login names

— User passwords (set to the associated user login name)

• If you migrate only roles, the script contains commands to update the 
Jetspeed database with the following information:

— Role names

— Group names (one group for each SIP role)

• If you migrate users and roles, the script contains commands to update 
the Jetspeed database with the following information:

— User login names

— User passwords (set to the associated user login name)

— Group names (one group for each SIP role)

— Associations of user login names to group names
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BEA WebLogic

The script for importing users and roles into a BEA WebLogic database is 
named setupBEASecurity_<portlet_app_name>.txt and is available in the 
following directory:

• Windows: <install_dir>\data\datafiles\dashboard\opview\
migratedData\scripts

• UNIX: /var/opt/OV/datafiles/dashboard/opview/
migratedData/scripts

The contents of the configuration script depend on what you migrate:

• If you migrate only users, the script contains commands to update the 
BEA WebLogic database with the following information:

— User login names

— User passwords (set to the associated user login name)

— User name strings

• If you migrate only roles, the script contains commands to update the BEA 
WebLogic database with the following information:

— Role names

— Group names (one group for each SIP role)

— Group descriptions

• If you migrate users and roles, the script contains commands to update 
the BEA WebLogic database with the following information:

— User login names

— User passwords (set to the associated user login name)

— User name strings

— Group names (one group for each SIP role)

— Group descriptions

— Associations of user login names to group names
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5 Using the Migration Wizard
The HP OpenView Dashboard Operations View Migration Wizard reads the 
HP OpenView Service Information Portal (SIP) configuration files but does 
not modify them in any way. Therefore, you can confidently migrate the 
configuration from your production SIP system and know that your SIP portal 
will continue to be available to all users while you prepare the updated portal 
views. In fact, you can run the SIP portal concurrently with migration and 
compare it to the Operations View deployment as one way of validating the 
new environment.

This chapter describes the processes for running the Migration Wizard.

The Migration Wizard overwrites some existing Operations View 
configuration files; therefore, complete the tasks described in Running the 
Migration Wizard before you begin configuration within the Administrator 
Tool.
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Migration Wizard Files

The Migration Wizard stages the SIP configuration on the Operations View 
computer. The Migration Wizard also places the migrated data files on the 
Operations View computer. Both staged files and migrated files are located in 
the following directory:

• Windows: <data_dir>\datafiles\dashboard\opview\migratedData

• UNIX: /var/opt/OV/datafiles/dashboard/opview/migratedData

Each Migration Wizard session creates a portlet application in the following 
directory:

• Windows: <data_dir>\datafiles\dashboard\opview\<portlet_app>

• UNIX: /var/opt/OV/datafiles/dashboard/opview/<portlet_app>

Additionally, Operations View maintains a backup of the previous migration 
only in the following directory:

• Windows:
<data_dir>\datafiles\dashboard\opview\migratedData\backup

• UNIX:
/var/opt/OV/datafiles/dashboard/opview/migratedData/backup

The migration process does not alter the SIP configuration in any way.
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Running the Migration Wizard

Use the Migration Wizard to convert the SIP configuration data to the 
Operations View data formats.

Task 1: Prepare for Migration

1 (Optional.) If you are doing a cross-system migration, set up the 
connection between the SIP server and the Operations View server.

a Mount the SIP configuration directory.

— Windows: Map a drive on the Operations View server to the SIP 
configuration directory.

— UNIX: Use the command specific to your platform to create a 
network mount point. For example, you might be able to use the 
mount command or the /etc/fstab functionality to mount the SIP 
configuration directory on the Operations View server.

b Copy the SIP 3.2 SIPPath.properties file into the root directory of 
the mapped or mounted drive. The SIPPath.properties file is 
located in webapps/ovportal subdirectory of the SIP installation 
directory.

c Ensure that you have write permission to the copied 
SIPPath.properties file. 

Migrating any or all of the management station, data filter, and module 
configuration overwrites some of the Operations View configuration files.

If you are not familiar with the Administrator Tool, it might be helpful to 
migrate only one or two modules first and then look at the resulting 
configuration in the Administrator Tool. Migration does not impact the SIP 
configuration, so you can practice migrating various portions of your data 
until you reach a desired result.

Note that the Migration Wizard creates a new portlet application for each 
session. You can use the portlet cloning functionality of the Administrator 
Tool to combine portlets from different portlet applications into a single 
portlet application.
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d Modify the copied SIPPath.properties file to point to the mapped or 
mounted directory. Save this copy with a unique name such as 
SIP32Path.properties.

— Windows: An example SIP32Path.properties file for the SIP 
directory mapped to the L: drive is shown here. In this example, 
select the L:\SIP32Path.properties file in Step 1 of Task 2: 
Select the SIP Definitions to Migrate on page 46.

— UNIX: An example SIP32PATH.Properties file for the SIP 
configuration on a different UNIX system with mount point
/mnt/SIP32/. In this example, select the
/mnt/SIP32/SIP32.properties file in Step 1 of Task 2: Select the 
SIP Definitions to Migrate on page 46.

2 Start the Operations View Administrator Tool:

Click Start→ All Programs→ HP OpenView→ Dashboard→ Operations View→ 
Administrator Tool.

• Windows: Click Start→ Programs→ HP OpenView→ Dashboard→ 
Operations View→ Administrator Tool.

• UNIX: In a terminal window, type: /opt/OV/bin/
ovopviewadmingui

SIP_SHARE_CONF_DIR=L:/conf/share/
SIP_FRAMEWORK_CONF_DIR=L:/conf/framework/
SIP_MODULE_REGISTRATION_DIR=L:/registration/
SIP_LOG_DIR=L:/log/
SIP_TMP_DIR=L:/tmp/
SIP_PASSWD_FILE=L:/etc/passwd
SIP_XSL_DIR=L:/conf/styles/
SIP_HOME_DIR=L:/

SIP_SHARE_CONF_DIR=/mnt/SIP32/conf/share/
SIP_FRAMEWORK_CONF_DIR=/mnt/SIP32/conf/framework/
SIP_MODULE_REGISTRATION_DIR=/mnt/SIP32/conf/
registration/
SIP_LOG_DIR=/mnt/SIP32/conf/log/
SIP_TMP_DIR=/mnt/SIP32/conf/tmp/
SIP_PASSWD_FILE=/mnt/SIP32/conf/etc/passwd
SIP_XSL_DIR=/mnt/SIP32/conf/conf/styles/
SIP_HOME_DIR=/mnt/SIP32/
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3 Start the Operations View Migration Wizard:

In the Administrator Tool, click Tools→ Launch 3.2->Operations View 
Migration.

4 In the Create Migration Staging Portlet Application page, specify the 
following information:

• Portlet Application Name: The name of the portlet application that 
will receive the 3.2 portlets. The portlet application name must be 
unique for this installation of Operations View (and not 
“migratedData”). Additionally, the portlet application name must start 
with a letter or underscore character, and consist of only 
alphanumeric and underscore characters.

• Description: Optional. A text string that describes the portlet 
application. For example, 3.2 portlets.

• Portal Server Vendor: The name of the portal server software. In this 
release, the supported portal server software products are Jetspeed 
1.6 and BEA WebLogic 8.1.

5 In the Welcome page, read the message. If the correct migration is listed, 
click Next.

If the specified portal server is not correct, click Cancel. In this case, you 
might want to delete the portlet application that was created in the 
previous step.

If portlet applications are deployed from multiple installations of 
Operations View into the portal server, ensure that the portlet 
application name is unique across all of these shared installations 
of Operations View.
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Task 2: Select the SIP Definitions to Migrate

Continue using the Migration Wizard to select the SIP 3.2 definitions that you 
want to migrate to Operations View.

1 In the Provide Location of 3.2 Source Configuration page, click Browse, 
and then navigate to the directory that contains the SIPPath.properties 
file for the SIP version 3.2 deployment. Select that file name, and then 
click Open.

2 The Analyzing Your SIP 3.2 Configuration page displays a progress bar 
while the Migration Wizard analyzes the configuration that the 
SIPPath.properties file points to. The Migration Wizard identifies and 
validates the information that can be migrated.

When the button becomes available, click Next.

3 The Select 3.2 Definitions for Migration page lists the number of 
definitions of each type in SIP 3.2. If you select to migrate modules, you 
can select a subset of modules in the next page.

For information to help you decide what SIP 3.2 definitions to migrate, see 
Chapter 3, SIP and Operations View Comparison and Chapter 4, 
Migration Use Options, or click Help.

The Migration Wizard displays messages regarding any potential problems in 
a separate window. To understand these messages, click Help in the window.

If you are using a mount point for the SIP deployment, select the 
copy of the SIPPath.properties file that you created in Step 1 of 
Task 1: Prepare for Migration on page 43.

If the SIP configuration is large or the network latency between the 
Operations View computer and the SIP computer is long, this step 
might take a while to complete.
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Select the types of SIP 3.2 definitions to migrate. Available options are:

• Management Stations: Migrates all SIP 3.2 management station 
definitions.

• Management Data Filters: Migrates all SIP 3.2 management data 
filters, customer model sources, and NNM simple customer model 
definitions.

• Modules: Migrates the SIP 3.2 module definitions that you select in 
the next page.

• Users: Creates a script for configuring all SIP 3.2 users in the portal 
server software.

• Roles: Creates a script for configuring all SIP 3.2 roles in the portal 
server software.

Migration of 3.2 module definitions also migrates the management 
station and management data filter definitions.
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4 If you selected to migrate modules in Step 3, the Select 3.2 Modules for 
Migration page displays a tree of the modules that are available for 
migration. The top level folders in this tree indicate the roles in the SIP 
configuration. Each entry also references the associated view. Each role/
view combination contains a folder for each sheet defined in that view. 
Expand a sheet folder to see the modules associated with that sheet.

You can use this page to fine tune the list of 3.2 modules to migrate. 
Initially, all modules are selected.

• To migrate all available modules, click Next.

• To migrate a subset of the modules, select the modules to migrate.

— Use SHIFT+click to select a contiguous range of modules.

— Use CTRL+click to select disconnected modules.

— Selecting a folder also selects all of its contents.

— The status bar shows a running total of the selected modules.

When all desired modules are selected, click Next.
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5 The Staging Progress page displays a progress bar while the Migration 
Wizard copies the selected definition files to the migration staging area. 
Any required modifications to the files are made during this step.

When the button becomes available, click Next.

If the SIP configuration is large or the network latency between the 
Operations View computer and the SIP computer is long, this step 
might take a while to complete.
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Task 3: Complete the Migration

Verify the listed information before continuing.

1 The Prepare for Migration page lists the following information:

• Target portal server

• Operations View portlet application

• Migration directory to receive the migrated data on the Operations 
View server

• Operations View configuration files that will be overwritten during 
the migration

When you are sure that all listed files can be overwritten, select the 
Overwrite All Below Files check box, and then click Next.

Carefully review the list of files that will be overwritten.
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2 The Migration Progress page displays a progress bar while the Migration 
Wizard moves the staged definition files from the migration staging area 
to the portlet application staging area. The files are now available to the 
Administrator Tool.

When the button becomes available, click Next.

3 Read the information in the Migration Complete page. If you chose to 
migrate users and/or roles note the location of the script containing the 
users and roles import commands. To close the page, click Finish.
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6 Manual Steps for Migration
After you have run the HP OpenView Dashboard Operations View Migration 
Wizard, use the Operations View Administrator Tool to make any desired 
changes and additions to the migrated configuration for management stations, 
data filters, and portlets. This process is similar for migrated configurations 
and completely new configurations.

This chapter describes the concepts of portlet and filter reduction. You might 
want to perform one or both types of reduction after migration. (See Portlet 
Reduction on page 55 and Role Reduction on page 59.) This chapter also 
explains how to import the user and role configuration script (created by the 
Migration Wizard) into the portal server. (See Users and Roles on page 62.)

For detailed information about the using the Administrator Tool and 
deploying a completed portlet application, refer to the Operations View 
Administrator Guide.
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Help File Migration

If the SIP help files contain links or images, those links may not function in 
Operations View. To fix this problem, either copy the images onto the 
Operations View server or update the links in the help files.

To migrate custom help for a SIP module, follow these steps:

1 Copy the help file(s) from the SIP computer to the following help directory 
within the portlet application staging directory on the Operations View 
computer. The C directory in the following paths is for the English locale.

• Windows: <data_dir>\datafiles\dashboard\opview\
<portlet_app_dir>\C\help

• UNIX: /var/opt/OV/datafiles/dashboard/opview/
<portlet_app_dir>/C/help

2 In the Administrator Tool, locate the migrated portlet that corresponds to 
the SIP module.

3 In the Help Content URI box, enter the appropriate reference to the help 
content. Specify the location relative to the portlet application staging 
directory.
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Portlet Reduction

Reasons for reducing the number of portlets that are migrated from the SIP 
module configurations include:

• Role reduction. If there are any roles defined in the SIP environment that 
are no longer necessary, a full migration will include the portlets for those 
roles.

• Duplicate configurations. If the SIP environment included multiple roles 
for the sole purpose of providing user-customizable views, some of these 
roles are redundant in the Operations View environment. The portal 
server now manages user customization of portal views, so you can create 
a standard portlet that is available to many users, and each user can 
customize the portlet look and feel according to their needs.

There are several ways to reduce the number of portlets in the migration 
portlet application. You can mix and match any of these approaches to best 
meet your situation:

• Migrate modules selectively. If you are familiar with the SIP 
environment, you can choose to migrate a subset of the modules that are 
in the SIP configuration.

— Select only those roles that are in active use.

— For modules that are in a view referenced by multiple roles, select only 
one of those modules.

• Use the Administrator Tool. SIP does not provide a user interface for 
working with the module configuration files; you must examine each XML 
file individually in a text editor. The Administrator Tool is a convenient 
way to examine the contents of each portlet configuration file without 
being concerned about the file names and locations. You can visually 
compare the contents of each portlet definition and select which portlets to 
keep and which to delete.

— As you compare portlet configurations, you may find some portlets 
that are almost identical with the exception of some portlet preference 
default values. Because portlet preferences can be customized by the 
portal user, you might need only one of these portlets.
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— For groups of portlets with similar configurations, one way to reduce 
the number of these portlets is to identify the portlet with the broadest 
configuration, delete the other similar portlets, and then use a 
combination of customer model configurations and filter assignments 
to replicate the functionality of the deleted portlets.

For example, consider a Migration Wizard session that resulted in the 
portlets shown in the scoping pane of the Administrator Tool shown in 
Figure 8 on page 57. The editor panes of Figure 8 on page 57 and Figure 9 
on page 58 show the portlet configuration of two OVIS portlets:

— AcmeBusinessServicesSheetmodule6

— AcmeBusinessServicesSheetmodule9

These portlet configurations are identical except for the value of the 
Default Time Period parameter.

— AcmeBusinessServicesSheetmodule6 has a Default Time Period of 4 
hours.

— AcmeBusinessServicesSheetmodule9 has a Default Time Period of 7 
days.

Because the Default Time Period parameter is a portlet preference (as 
indicated by the bold typeface in the portlet editor), a portal view user can 
change this value after the portlet is deployed. Thus, either one of the two 
OVIS portlets is sufficient to cover the functionality provided by both 
portlets. We can use the Administrator Tool to delete one of the two 
portlets, thereby reducing the number of portlets to manage.
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Figure 8 OVIS Portlet with Four Hour Interval
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Figure 9 OVIS Portlet with Seven Day Interval
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Role Reduction

In SIP version 3.2, a portal role dictates data filtering and view files. With 
Operations View, data filtering and portal view management are 
accomplished differently. Because of these differences, you might be able to 
support the same portal functionality in Operations View with fewer user 
roles than in SIP 3.2.

The Migration Wizard migrates all of the SIP management data filter 
definitions into Operations View filter assignments and maintains the same 
role-to-filter relationships configured in SIP 3.2. If you decide that you can 
reduce some portal roles, use the Filter Assignment editor in the 
Administrator Tool to modify the migrated filter assignment definitions to 
work with the reduced set of portal roles.

This section describes two scenarios for which it is possible to reduce the 
number of SIP 3.2 portal roles because of changes in Operations View 
functionality.

Role Reduction Because of Management Data Filter Changes

In SIP version 3.2, a role can use only one management data filter. To support 
displaying data from different management data filters, a SIP user is typically 
associated with multiple roles. A SIP environment commonly includes 
multiple roles in order to provide user-customizable views.

In Operations View, filter assignments replace the SIP 3.2 management data 
filters. Filter assignments include a security constraint that controls which 
users receive access to each data filter. The security constraint includes a 
designation of portal roles. This subtle change in data filtering means that, in 
some environments, many SIP roles can be reduced to a much smaller number 
of Operations View roles. 

The following example demonstrates the reduction of two roles to one.

Table 5 shows a pre-migration SIP configuration containing two roles, RoleA 
and RoleB, and two management data filters, FilterA, and FilterB. In SIP, the 
two management data filters are required in order to filter module data 
differently, and the two roles are required to provide the output of the two 
management filters to an end user belonging to both RoleA and RoleB. That 
user sees the output from FilterA or FilterB, depending the current role.
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In Operations View, one role can be associated with many filter assignments, 
and an end user can choose which filter assignment to use in the deployed 
portlet. As a result, you do not need two roles for the purpose of providing the 
views of two different filters. You can associate both filters to one of the two 
roles and remove the other role. Table 6 shows the use of RoleA to achieve the 
same results as in SIP; RoleB is no longer needed.

Role Reduction Because of Portal View Customization Changes

In SIP version 3.2, each role has a view file and module configuration. The SIP 
environment commonly includes multiple roles in order to provide 
user-customizable views.

Within a BEA WebLogic portal, portlet preferences are user-specific, which 
means that you can create a portal view (BEA WebLogic portal desktop) that 
is available to many users, and each user can customize portlets according to 
their needs. This approach achieves the same effect as creating many portal 
roles within SIP 3.2.

Table 5 Example: SIP Role-to-Data-Filter Relationship

SIP Role SIP Management Data Filter

RoleA FilterA

RoleB FilterB

Table 6 Example: Operations View Role-to-Filter Assignment 
Relationship

Portal Role Operations View Filter 
Assignment

RoleA FilterA

RoleA FilterB

This topic applies to the BEA WebLogic portal server only.
60 Chapter 6



Version 2.0 HP OpenView Dashboard Operations View Migration Guide
Reducing the number of roles to account for changes to portal view 
customization is most useful when the SIP 3.2 portal views are similar in 
layout with module configurations varying to accommodate multiple users. 
With Operations View, you can defined one BEA WebLogic portal view and 
allow users to set their portlet preferences.
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Users and Roles

If you chose to migrate SIP users and/or roles, perform the procedures in this 
section.

1 (Optional.) Modify the script that the Migration Wizard created. See 
Modify the Script (Optional).

2 Run the script on the portal server. See Create Jetspeed Users and Roles 
on page 63 or Create BEA WebLogic Users and Roles on page 65, as 
appropriate.

3 Complete user and role configuration by using the portal server software 
tools. See Complete User and Role Configuration on page 66.

Modify the Script (Optional)

As created by the Migration Wizard, the portal server configuration script sets 
each user’s password to be the same as the user login name. You can modify 
the passwords before configuring the users in the portal server database. You 
can also update other information about the users named in the script.

To modify the portal server configuration script, follow these steps:

1 Open the user/role configuration script in any text editor.

For Jetspeed, the script is available in the following location:

• Windows: <data_dir>\datafiles\dashboard\opview\
migratedData\scripts\
setupJetspeedTurbineSecurity_<portlet_app_name>.sql

• UNIX: /var/opt/OV/datafiles/dashboard/opview/
migratedData/scripts/
setupJetspeedTurbineSecurity_<portlet_app_name>.sql

If you add password information to the script, do not leave it in an 
unprotected location.
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For BEA WebLogic, the script is available in the following location:

• Windows: <data_dir>\datafiles\dashboard\opview\
migratedData\scripts\
setupBEASecurity_<portlet_app_name>.txt

• UNIX: /var/opt/OV/datafiles/dashboard/opview/
migratedData/scripts/
setupBEASecurity_<portlet_app_name>.txt

2 The password is the same as the user login name. Modify the password as 
appropriate for each user.

3 Optionally provide additional information such as first and last name for 
each user.

Create Jetspeed Users and Roles

To perform user and role configuration in the Hypersonic SQL database using 
the user/role configuration script, follow these steps on the Jetspeed portal 
server.

1 Stop Jetspeed and the HSQL database.

• Windows: Stop the HP OpenView Dashboard Jetspeed 1.6 service.

• UNIX: /opt/OV/lbin/dashboard/jetspeed/1.6/
ovdshbdjetspeed.sh stop

2 Open the Hypersonic administrative tool.

• Windows:

— Change to the <install_dir>\nonOV\dashboard\jetspeed\
1.6\jakarta-tomcat-5.5.9\webapps\jetspeed\WEB-INF\db 
directory.

— Run the manageDB.bat script.

If your Jetspeed installation uses a different database, perform similar 
configuration steps for that database.
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• UNIX: 

— Change to the <install_dir>/nonOV/dashboard/jetspeed/
1.6/jakarta-tomcat-5.5.9/webapps/jetspeed/WEB-INF/db 
directory.

— Run the manageDB.sh script.

3 In the HSQL Database Manager, click File→ Open Script, and then select 
the user/role configuration script identified in Step 1 of Modify the Script 
(Optional) on page 62. You can safely ignore the warning that this file 
cannot be edited as shown here.

4 Click Execute.

You should not see any error messages in the window below the execute 
button, and you should see a message that rows have been updated.
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5 Click Options→ Commit to save your changes.

6 Close the HSQL Database Manager.

7 Start Jetspeed:

• Windows: Start the HP OpenView Dashboard Jetspeed 1.6 service 
from the Windows Services control panel.

• UNIX: /opt/OV/lbin/dashboard/jetspeed/1.6/
ovdshbdjetspeed.sh start

Create BEA WebLogic Users and Roles

To perform user and role configuration using the user/role configuration 
script, use the weblogic.Admin command in batch mode to process the portal 
server configuration script identified inStep 1 of Modify the Script (Optional) 
on page 62. The following steps are an example of performing user and role 
configuration with the BEA sample portal domain.

1 If the portal domain is not already running, start it:

• Windows: <bea_install_dir>\weblogic81\samples\domains\
portal\startWebLogic.cmd

• UNIX: <bea_install_dir>/weblogic81/samples/domains/
portal/startWebLogic.sh

2 Start a command prompt session for using the weblogic.Admin 
command.

3 Initialize the domain environment variables in the new command prompt 
session:

• Windows: <bea_install_dir>\weblogic81\samples\domains\
portal\setDomainEnv.cmd

• UNIX: <bea_install_dir>/weblogic81/samples/domains/
portal/setDomainEnv.cmd

4 Run the weblogic.Admin command in the command prompt session. 
Modify the following command line for your domain configuration:

java weblogic.Admin -url localhost:7001 -username 
weblogic -password weblogic BATCHUPDATE -batchfile 
"setupBEASecurity_<portlet_app_name>.txt" 
-batchCmdVerbose
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5 Optional: Correct any error messages, and then re-run Step 4.

You can probably ignore errors such as user names already existing in the 
portal domain. For more information, refer to BEA documentation.

Complete User and Role Configuration

Using the portal server software tools, add any users or roles that did not exist 
in SIP.

If you migrated SIP users but did not change user login passwords in the user/
role configuration script before running it on the portal server, either change 
each user login password at this time or require each user to make this 
change.
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This appendix consolidates the recommended best practices for migrating 
from HP OpenView Service Information Portal (SIP) version 3.2 to 
HP OpenView Dashboard Operations View version 2.0. These 
recommendations are also included in other places in this manual.

• If your Operations View configuration will be very different from your SIP 
configuration, consider building your Operations View configuration by 
hand.

• Migrate your existing SIP configuration before doing any configuration 
work in the Operations View Administrator Tool. The migrated files 
overwrite some of the existing Operations View configuration files. Any 
changes that you have already made will be lost.

• If you are not familiar with the Administrator Tool, it might be helpful to 
migrate only one or two modules first. (You can follow the procedure in 
Migration Wizard Files on page 42.) Then, look at the resulting 
configuration in the Administrator Tool. Migration does not impact the 
SIP configuration, so it is very safe to practice migration.

• Because the management station and data filter configurations migrate 
from SIP to Operations View in a one-to-one manner, se the Migration 
Wizard to migrate this information.

• If your portal views in the Operations View environment will be very 
similar to the portal views in the SIP environment, use the Migration 
Wizard to migrate all module definitions.

• If you have decided to reduce the number of role definitions, you should 
not migrate all of the modules that are presented in the Migration Wizard. 
Migrating all of these modules will produce duplicate portlet definitions. 
For ways to handle this situation, see Portlet Reduction on page 55 and 
Role Reduction on page 59.
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• If the Operations View user and role definitions will be very similar to 
those used in the SIP configuration, it can be helpful to work with the 
user/role script created by the Migration Wizard. Either edit the script to 
include correct passwords before running it on the portal server computer 
or configure the user passwords using the portal server tools. For 
information, see Users and Roles on page 62.

SECURITY: If you add password information to the portal server 
configuration script, do not leave the script in an unprotected location.
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Glossary
A

access privilege

A permission granted to a principal to perform a specific operation or business 
function. Also called entitlement.

authentication

The process by which a user identifies and validates him/herself to the portal 
server.

authentication provider

A configured component of the portal server that authenticates users who 
attempt to use the system.

authorization

The granting of access privileges to an authenticated user. The granted access 
privileges determine what the user can see and do while logged in to the 
portal server.

B

bookmark

A link to content that can be displayed in a web browser.

bookmark group

A named list of one or more bookmarks.
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C

configuration

The combination of software parameters and attributes that determine the 
way the software works, the way it is used, and how it appears.

configuration file

A file that contains specifications or information that can be used for 
determining how a software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a 
specified environment, application, or usage.

customer

An entity (person or organization) that receives services offered by a service 
provider.

customer data filtering 

The use of attributes as a mask for constraining the data that is to be acted 
on, used, or displayed in the user interface. In HP OpenView Dashboard 
Operations View, customer data filtering is one aspect of a filter assignment.

customer model

A mapping of customers to resources, where resources are associated hosts, 
interfaces, or services.

customer model source

A configured URL or file that provides the mappings or partial mappings of 
customers to resources.

customize

To design, construct, or modify software to meet the needs and preferences of a 
particular customer or user. For HP OpenView Dashboard Operations View, 
customizing is synonymous with assigning to customers what will be 
displayed to them. Operations View customization tasks include customizing 
content, customer filtering, and the setting of options.
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customization 

The process of designing, constructing, or modifying software to meet the 
needs and preferences of a particular customer or user.

D

desktop

A BEA WebLogic term. See portal view.

E

entitlement

A BEA WebLogic term. See access privilege.

extend

The act of increasing the capabilities, scope, or effectiveness of a program. The 
capabilities of HP OpenView Dashboard Operations View can be extended 
through the HP OpenView Integration portlet.

extensible

Capable of being extended.

F

filter

A set of attributes and values that act as a pattern or mask through which 
data is passed. Filters allow matching-relevant information to be extracted 
and acted on while non-matching-irrelevant information is blocked.

filter assignment

The security mechanism that defines what data is displayed through the 
portal.
71



J

JDK

Java 2 Software Development Kit. Also called J2SDK.

JAR file

Java archive file. Contains compiled Java classes and the associated data that 
can constitute a program.

JSP

Java server page

JSR168

The technical specification that defines interoperability between portlets and 
portal servers. The HP OpenView Dashboard Operations View portlets are 
JSR168-compliant. For more information, refer to the Java Community 
Process website at http://www.jcp.org.

JVM

Java virtual machine

M

management data filter

In HP OpenView Service Information Portal, the security mechanism that 
defines what data is displayed through the portal. Operations View uses the 
term “filter assignment.”

management station

A computer on which one or more management software products runs.

message

A communication using text and/or images. In HP OpenView Dashboard 
Operations View, messages are presented to customers via the Operations 
View Message Board portlet.
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message content

The information that is presented in a message. Message content may include 
text and/or graphics.

module

In HP OpenView Service Information Portal, a self-contained software 
component that performs a specific type of task or provides for the 
presentation of a specific type of data. Modules can interact with one another 
and with other software. Modules present specific sets of functionality to the 
user through the portal framework. Operations View uses the term “portlet.”

N

navigation aid

A link on a portal page that allows navigation to another portal page. 
Navigation aids can appear as tabs across the top of a portal or as a list along 
the side of a portal. Similar types of portlets can be grouped together and 
accessed from a single navigation aid.

NNM

HP OpenView Network Node Manager

O

operator 

The role of a person who uses a management application to perform a 
specified subset of management tasks.

OVIS 

HP OpenView Operations Internet Services

OVO 

HP OpenView Operations

OVPI 

HP OpenView Performance Insight
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OVPM 

HP OpenView Performance Manager

OVR

HP OpenView Reporter

OVSD 

HP OpenView Service Desk

OVSN

HP OpenView Service Navigator

P

page

A single display or presentation of information on the World Wide Web. 
Typically, a web page consists of an HTML file, referenced graphics files, and 
associated scripts.

PDF 

Portable Document Format

port 

A location for passing information into and out of a network device. 

portal

A web site that provides a variety of different types of information and serves 
as a gateway to other web sites. HP OpenView Dashboard Operations View 
provides portlets that can be incorporated into a portal. See portal server 
software.

portlet application

A group of JSR 168-compliant portlets combined with functionality that is 
specific to the target portal server product. Packaged in a WAR file and viewed 
through its portlets. Also called “portal project.”
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portal server

The computer that hosts the portal server software.

portal server software

A program that acts as the basic structure to support other software portlets 
or programs that provide additional functionality for the user. HP OpenView 
Dashboard requires the use of a supported third-party portal server software 
product.

portal view

A set of portlets, navigation aids, and view properties within a portal. A portal 
view can be shared by multiple users. A Jetspeed portal view configuration is 
maintained in a PSML file. A BEA WebLogic portal view is called a “desktop.”

portal view file

In HP OpenView Service Information Portal, a configuration file that contains 
specifications or information that can be used for determining how software 
should look to a given user. Portal view files are XML files that contain all 
information needed to render a portal view. In Operations View, the portal 
server software tools create and maintain the portal view configurations.

portlet

A self-contained software component that performs a specific type of task or 
provides for the presentation of a specific type of data. Portlets can interact 
with one another and with other software. In Operations View, portlets 
present specific sets of functionality to the user through the portal framework. 
Examples of portlets include the Message Board, Service Browser, Network 
Device Health, and the Alarm Portlet.

portlet initialization parameter

A portlet configuration parameter that is set in the Operations View 
Administrator Tool and cannot be changed by portal view users. Each user of a 
given portlet always sees the same results of the portlet initialization 
parameters.

portlet mode

That which determines the operations that are available to a portlet user 
through the portal interface. Operations View supports three distinct portlet 
modes: edit, view, and help. The edit mode allows portlet users to change the 
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portlet configuration. The view mode allows portlet users to see the portlet. 
The help mode allows portlet users to access portlet help information.

portlet preference

A portlet configuration parameter that is set in the Operations View 
Administrator Tool and can be modified by portal view users who have the 
edit portlet mode.

PSML

Portal Structure Markup Language. See portal view.

R

role

That which defines what a user can see and do through the portal at a 
particular point in time. A role can be shared by multiple users.

S

SIP

HP OpenView Service Information Portal. The precursor to HP OpenView 
Dashboard Operations View.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides 
management capabilities specific to a given type of business application, 
database, operating system, or service.

SPI 

See SMART Plug-In (SPI).

SQL 

Structured Query Language

SSL 

Secure Sockets Layer
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system administrator 

The role of a person who does configuration and maintenance on a computer 
system or the software on the system.

U

URI 

Uniform Resource Identifier

URL 

Uniform Resource Locator

user 

A person who uses a software application, a computer or service. A user can 
have one or more roles. For example, a network administrator or operator role.

user preferences

The attributes that are associated with a specific user.

W

WAR file

Web application archive file. A specially structured JAR file that contains the 
functionality to deploy and support a portlet application. Contains the 
web.xml and portlet.xml deployment descriptor files. Might also contain JSPs, 
servlets, and other data.

X

XML 

Extensible Markup Language

XSL 

Extensible Style Sheet Language
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XSLT 

Extensible Style Sheet Language Transformations
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